EPSON RC700A Startup Guide



VERSION 5.3.0

The documentation, best practices, and recommendations provided by
READY Robotics do NOT constitute safety advice. Products sold through
READY Robotics are not by themselves a fully integrated workcell. As
required in ISO 10218-2, READY Robotics strongly recommends
performing a complete risk assessment of the integrated workcell per
ISO 12100. You may wish to use the methodology found in the ANSI/RIA
TR R15.306 Task-based Risk Assessment Methodology.
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OVERVIEW

This guide helps you set up your EPSON robot to work with Forge/OS 5.

You will complete these steps:

—_

Check for the requirements.

Connect all the devices and power on.

Set up Forge/OS.

Transfer Forge/OS robot configuration files to the robot.

Configure the robot in RC+ and Forge/OS.

I O

Program your robot with Forge/OS!

Note: This guide assumes that you have installed the robot following EPSON instructions.

Important: Before you start programming, please read the Known Issues section. The robot may behave
unexpectedly when near a singularity. THESE ISSUES ARE NATIVE TO EPSON AND NOT AT THE FAULT OF
FORGE/OS.
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HARDWARE REQUIREMENTS

Part Name Description Vendor Part Number
Hosts Forge/QOS.
Industrial PC Note: Refer to the Forge/OS 5
(IPC) User Manual for IPC
requirements.
The touch screen interface for READY
READY pendant Forge/OS. Robotics 112563
Robot Connects the robot arm to power EPSON
Controller and to other devices.
EPSON
USB A-Male to Connects a Windows PC to the (Included
B-Male Cable robot controller. with
robot)
Required to load Forge/OS
Windows PC configuration files to the robot
controller.
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Part Name

Description

Part Number

Emergency Connects the robot controller to
Terminal Block the READY pendant and safety EPSON RE000975-1
Kit (with Cable) devices.
Powers the READY pendant and
24V/2.5A other devices. e.g, Siemens
Power Supply Min./Max. current: 2.5/5.0 Amps. 6EP1332-5BA00
Polycarbonate Protects the Terminal Block Kit and
Enclosure or the Power Supply in an enclosure
Cabinet PPy '
= Connects the robot controller to
Cat5e Shielded an IPC.
Ethernet Cable '(\:/'CMaSter' 773476
(x2) = Connects the READY pendant arr
toan IPC.
USB Flash Drive READY
(with at least Transfers Forge/OS configuration Robotics
) . R-400030
2GB of available | files to the robot controller..
(or other)

memory)
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SOFTWARE REQUIREMENTS

EPSON RC+ is the software that you use to communicate with the robot in its native language. Access to the full
version of RC+ came with the purchase of your robot. Install it on a Windows PC to load Forge/OS configuration
files.

Note: EPSON offers a free trial of RC+ for testing on a simulated robot. This free trial will NOT work for setting up
Forge/0OS.

Important: If you have built or loaded projects on the controller before, you may need to do a factory reset.
Contact EPSON Support for help.

Refer to the table below for the minimum required RC+, controller firmware, and Forge/OS versions.

Controller Minimum Software Version

RC+ 7.0, Compiler v7.4.0.x

RC700/A
Firmware v7.5.3.0

Tip: Refer to Checking the Firmware Version for instructions on how to check your controller firmware version.
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CRECKING THE FIRMWARE VERSION

Follow these steps to check what firmware version your EPSON controller is on.

Plug the USB Cable into the robot controller's PC port. Plug the other end into a Windows PC with EPSON RC+
installed.

a Open EPSON RC+ in Program Mode.

= If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.

= If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.
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u If you set a password, enter it. Then click OK.

If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it
after Program Mode boots, click No.
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If you see a pop-up about current tasks running, select Stop all tasks.

G In the top menu, select a Connection type of USB.

Tip: The USB option is only available when:
= You are using the full version of RC+.

= Your USB cable is connected to the robot controller and Windows PC.
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q Go to Tools. Select Controller in the dropdown.

ﬁ EPSOM RC+ 7.5.0 - Project C\EpsonRC70NProjects\ready-epson-driver\ EPSON_DRIVER
File Edit View Project Run | Tools | Setup Window Help

F&
Citrl+M
Cirl+l
Ctrl+T

Cirl+L
Cirl+U

Cirl+F5
GUI Builder Cirl+F7
= Conveyor Tracking Ctrl+F2

G Click Backup Controller.
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u Select the location where you would like to store your backup. Click OK.

G Click View Controller Status.
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G Select the backup file that you just created. Click OK.

a Find the Firmware Version.

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 13



VERSION 5.3.0

CONNECTING THE ROBOT CONTROLLER

u Plug an Ethernet cable into the LAN port on the robot controller. Plug the other end into a LAN port on your
IPC.

Plug one end of the EPSON Emergency Cable into the EMERGENCY port on the robot controller. Plug the other
end into the Terminal Block Kit.
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CONNECTING THE READY PENDANT

The READY pendant includes these safety outputs:

1. Key Switch (Robot Operation Mode)
2. Three-Position Enabling Switch
3. Emergency Stop Button

Note: For EPSON robots, you connect the READY pendant Emergency Stop, but not the Key Switch and
Enabling Switch. Always perform a risk assessment and use appropriate safeguards, like a safety fence.
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ﬂ Wire the READY pendant cable's flying leads to the Terminal Block Kit:

Pendant Cable | EPSON Emergency Connector | External 24 VDC Power Supply | Function
Brown N/A Enabling Switch
Yellow N/A Enabling Switch
Green N/A Enabling Switch
Grey N/A Enabling Switch
Pink 24V
Green/Brown Pin 1 Emergency Stop
White/Green Pin9 Emergency Stop
Grey/Pink Pin 10 Emergency Stop
Red/Blue Pin 14 Emergency Stop
Black ov
Violet N/A Key Switch
White/Pink N/A Key Switch
White N/A Key Switch
Blue N/A Key Switch
White/Blue N/A

Pin2,3 Jumper

Pin 15, 16 Jumper

Pin 4,1 Jumper

Pin 12,17 Jumper
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Wire the safeguard device (e.g., safety fence) and latching system. You can wire a button or switch to the latch
release pins to control the latching mechanism. Or you can jumper the latch release inputs so the safeguard
auto resets when you close the fence (shown in the table below).

EPSON Emergency External 24V Power Safeguard .
: Function
Connector Supply Device
Safeguard .
24V Contact 11 Safeguard Input 1 Circuit
. Safeguard o
Pin7 Contact 12 Safeguard Input 1 Circuit
Pin 8 oV Safeguard Input 1 Circuit
Safeguard A
24V Contact 21 Safeguard Input 2 Circuit
. Safeguard o
Pin 20 Contact 22 Safeguard Input 2 Circuit
Pin 21 oV Safeguard Input 2 Circuit
Pin 18 24V Latch Release Input
(Jumpered)
Pin 19 24V Latch Release Input
(Jumpered)

Tip: Refer to EPSON documentation for more information on safeguard wiring and pin assignments.

into a LAN port on your IPC.

q At the end of the READY pendant cable is a black Ethernet cable. Connect it to a longer Ethernet cable to plug
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POWERING ON

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 18



VERSION 5.3.0

SIGNING IN TO FORGE/OS

Follow these steps to pair the READY pendant with the IPC and sign in to Forge/OS 5.

If you need to install Forge/OS 5 on your IPC, stop here and follow all the steps in Appendix A, then come back
to these steps.

a The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:

= Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e.,, the Ethernet cable is plugged in).

= Forge/OS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on
the network.

= Forge/OS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the
IPC. If pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a
spinner around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED
turns green.

The Ul shows the real-time state of each step. For example, if the pendant loses its network connection during
pairing, all steps become undone.

If the READY pendant spends more than 60 seconds on any step, troubleshooting text displays. Common things
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to check are if the READY pendant network cable is plugged in, if the IPC is powered on, if the READY pendant

and IPC are connected to the same network, and if there's only one READY pendant and one IPC on that
network.

Note: The READY pendant IP Address is preset to 172.16.255.253. The network interface that the pendant
connects to should use IP Address 172.16.255.250 and Subnet mask 255.255.255.0.

If Forge/OS is inactive, it opens the Settings app and prevents you from opening other apps. If you see the
screen below, follow Activating Forge/OS with a License Code in Appendix A.
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DEVICE CONFIGURATION - PT.1

u In the Admin role, open the Device Configuration app.

a Tap New + to open the Device Library.
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e In the Device Library list, select EPSON industrial robot. Then tap NEXT.
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u Select RC700 for the Controller Model. Then select your Robot Model. Fill in the other information later.

Insert a USB flash drive into the IPC as instructed on the screen. Use an empty flash drive with at least 2GB of
storage.

Tip: Do not connect the USB flash drive to the READY pendant.
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IMPORTING THE PROJECT IN RC+

a In File Explorer, go to your USB flash drive's storage. Open the forge-os folder.
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e In that forge-os folder, right-click the ready-epson-driver folder to copy it.

a In your Windows (C:) drive, open the EpsonRC70 folder that was made when you installed the EPSON RC+
software.
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G In that EpsonRC70 folder, open the projects folder.

G In that projects folder, right-click to paste the ready-epson-driver folder that you copied.
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Open RC+ in Program Mode.

= If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.

= If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.

q If you set a password, enter it. Then click OK.

If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it
after Program Mode boots, click No.
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m If you see a pop-up about starting another session, click Yes.

u If you see a pop-up about current tasks running, select Stop all tasks.

G In the menu bar across the top of EPSON RC+, open the Project tab. Click Import.
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G Set the import location as PC. Then click Next.

m Select a project type of EPSON RC+ 7.x. Select the copied "ready-epson-driver" project. Then click Next.
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G Type "EPSON_DRIVER" in the Destination Project Name field. Then click Next.

G Select the Open Destination Project After Import checkbox. Then click Import.
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CONFIGURING THE ROBOT

u Expand the Connection dropdown in the top-right corner. Select USB to connect to your robot.

Tip: The USB option is only available when:
= You are using the full version of RC+.

= Your USB cable is connected to the robot controller and Windows PC.

a In the top menu bar, select Setup. Go into System Configuration.
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e The Startup menu automatically appears. If Auto mode is not already selected, select it and click Apply.

u In the Controller menu, select Configuration:

Set the IP Address to 192.168.1.20 and set the Subnet Mask to 255.255.255.0.

Select a Control Device of Remote 1/0. This allows your robot to run through a READY pendant instead
of through a Windows PC.
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G In the Controller menu, select Preferences:

G Uncheck Virtual 1/0 to disable it.
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G In the Inputs/Outputs menu, select Fieldbus Slave. Select a Fieldbus Type of Modbus TCP. Click Apply.

In the TCP/IP menu, set the TCP/IP Ports to the values listed below. Use the same IP Address as earlier for
each port.

Set Port 201 to 49152, enter the correct IP address, then Apply.
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q Open the Project tab. Click Properties.

m In the Compiler menu, expand the Compiler Version dropdown. Select 7.4.0.x (or later).
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Click Apply, then Close out of the pop-up.
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BUILDING THE DRIVER

It's time to build the driver. This step sends the program files to the robot.

ﬂ In the top menu bar, open the Project dropdown. Click Build.

a If you see the prompt below, select Yes to overwrite the project on the controller.

[ EPSON RC+ 7.5.0 - Project CAEpsonRCTD\Projects\ EPSON_DRIVER - O
File Edit View Project Run Tools Setup Window Help
D @& & BRI EET =@ D3 B . B S %0 E @ o Connection: USB

T e 2 x
=423 Program Files ~
- [E] lb_am_ral prg

= lib_am_rabet.prg
lib_am_ser_chor.prg

] b_amays o EPSOMRC+ 7.0
lib_commands prg
- [E] lib_functions prg
- Wi g

lib_queue prg 0 armning

lib_ral prg Praject in controller is 'EPSON_DRIVER', This is not the same
lib_robet.prg as current PC project.
lib_robet_functions.prg ) )

lib_ser_cbor.prg The project in the controller will be overwritten,
- [E] main prg Continue?

main_motion prg
- [E] main_state pra
main_system prg
motion_master prg
motion_metion_circular prg
motion_motion_jog.prg

- [EZ] mation_metion_jaint prg

motion_motion_linear.prg
motion_motion_pause_resu
-] mation mation setecale o
¥

v

<

Status
15:14:09 Linking...

Program EStop Safety Error Wamning Robet: 1, WTBAS01S, VT6-A901S  No Tasks Running

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED



VERSION 5.3.0

e Check that you have a successful build by looking for a "Build complete, no errors" message in the Status
window.

Status

15:32:26 Sending tests_language_strings_test_strings.prg
15:32:26 Sending tests_language_strings_test_string_asciiprg
15:32:26 Sending tests_language_strings_test_string_compare.prg
15:32:26 Sending tests_language_strings_test_string_concat.prg
15:32:27 Sending tests_language_sinngs_test_string_operations.prg
15:32:27 Sending lib_ral prg

15:32:27 Sending lib_ser_char.prg

15:32:27 Sending systern_state_allcommands.prg

15:32:27 Sending lib_arr_ser_chor.prg

15:32:27 Sending lib_arr_ral pro

15:32:28 Sending lib_arr_robot prg

15:32:28 Sending lib_gqueue.prg

15:32:28 Sending robot] pts

15:32:28 Sending EPSOM_DRMWER. spr

15:32:28 Sending EFSON_DRIVER. ohj

15:32:29 Sending [OLabels.dat

15:32:29 Sending UserErrors.dat

15:32:29 Sending EPSOM_DRIWER.vis

15:32:29 Sending EPSOMN_DRMER. fg

15:32:29 Loading project in controller...

15:32:30 Build complete, no errors

Tip: If you see build errors, refer to Appendix C: Troubleshooting.
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STARTING THE DRIVER

u In the top menu bar, open the Run dropdown. Click Run Window.

a To start the driver in Remote I/0O mode, click Enable Remote 1/0.
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e In the pop-up below, click Yes to start BGMain.
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DEVICE CONFIGURATION - PT.2

In these steps, you save the robot in the Device Configuration app and finish the setup.

u Finish entering your EPSON device information.

Give your device a name.
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In Forge/OS, confirm your device settings and tap SAVE. Forge/OS attempts to connect with the robot
controller for up to 20 seconds.

Note: When you first connect to a robot, it's normal to see some robot errors and/or warnings on the
READY pendant. Ignore these for now. You will clear them after you finish adding the robot to Forge/OS.

u If the robot controller fails to connect, you see this pop-up.

Click DISMISS, do the following, then try to tap SAVE again:
= Check the Ethernet connection between the robot controller and IPC.

= Check the network settings on the robot controller.
= Check if the robot controller is on and in the correct operating mode (in auto or remote mode).

= Select the correct robot controller and robot models in Device Configuration.

When the robot connects, you can add Tool Center Points (TCPs) or Payloads for the robot. You can come back
to this later by editing the device's configuration. Tap SAVE to continue.

Note: The default TCP is at the robot's tool flange. The default Payload is zero.

u (Optional): Set up the robot controller's Input/Output (10) signals for use in the Device Control Panel and Task
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Canvas.

show what each signal does in other apps.

q Enter a Display Name (i.e. "Open Machine Door", "Open Pneumatic Vise", or "Start Machining Cycle") to

If you want a signal to appear in the Device Control Panel, check the DCP box next to that signal.

Note: To use these I/0 signals, integrate your I/0 devices with the robot controller.

Tap SAVE. Forge/OS returns to the Configured Devices list, which shows the new robot as enabled.

Note: A device is enabled when its switch is green and toggled to the right.

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 43



VERSION 5.3.0

G Follow these steps to clear robot errors:

Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with
two buttons: MORE and RESET.

and instructions.

q Tap RESET to try to recover from the errors. If you can't RESET an error, tap MORE to get more details

Congratulations! You are ready to control your robot in the Device Control Panel and Task Canvas apps.
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CLOSING RC+

You can now control the robot arm with just the READY pendant. Follow these steps to disconnect your PC from
RC+.

ﬂ Unplug the USB cable from your Windows PC and robot controller. A "Communication disconnection detected"
pop-up appears in RC+.

Check the READY pendant for errors, such as the "Communication Disconnection Between RC+ and Controller"
error. Follow these substeps to resolve it:

Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with
two buttons: MORE and RESET.

Tap RESET to try to recover from the error. If you can't RESET the error, tap MORE to get more details and
instructions.
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APPENDIX A: SETTING UP FORGE/QS
INSTALLING FORGE/0S

Follow these steps to install Forge/OS and sign in to the Admin role. Installation takes about 30 minutes,
depending on the resources of the IPC.

ﬂ To install Forge/OS, follow these substeps. You need a Forge/OS installation USB flash drive. Contact your
READY Robotics distributor for an installation USB drive.

Important: Installing Forge/OS will erase all data on the target hard drive.

u Connect a monitor, keyboard, and mouse to the IPC where you want to install Forge/OS.

u Plug the Forge/OS installation USB flash drive into the IPC.

Tip: If you need more USB ports, use a USB 3.0 hub.

G Restart the IPC. While the IPC is powering on, press the keyboard hotkey that takes you to the Boot Menu.

Tip: The key that opens the Boot Menu depends on the IPC model. The most common keys that do this
are ESC, F10, F11, or F12. Refer to your computer's documentation for boot options.
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u Select your language. Then click Install Forge.

q Choose a keyboard layout. Then click Continue.
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u Select Minimal installation. Uncheck Download updates while installing forgeos. Then click Continue.

u Select Erase disk and install forgeos. Then click Continue.

Note: If Forge/OS is already installed, the installation wizard will show additional options. The goal is to
erase the entire disk for a brand new installation.
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u Select the IPC hard drive for Forge/OS and click Install Now.

u Make a note of the pendant instructions. If you're using a Forge/Ctrl, select the checkbox next to This
hardware is a Forge CTRL.
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ﬂ Choose your timezone. Then click Continue.

Choose your IPC's host name. The host name identifies the IPC on the network. Pick a username and
password. Then click Continue.

Note: The username and password that you create here are for accessing the IPC desktop. They are
NOT for signing into Forge/OS on the READY pendant.

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 50



VERSION 5.3.0

u Wait for the installer to copy and install Forge/OS.

Flease remove the installation medium, then reboot.
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G When you see the login screen with the Forge/OS 5 logo, Forge/OS is ready to run on the
READY pendant! You don't need to sign in to the desktop. Disconnect the monitor, keyboard, and mouse
that you used to install Forge/OS.
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e The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:

= Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e, the Ethernet cable is plugged in).

= Forge/OS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on
the network.

= Forge/OS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the
IPC. If pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a

spinner around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED
turns green.

The Ul shows the real-time state of each step. For example, if the pendant loses its network connection during
pairing, all steps become undone.

If the READY pendant spends more than 60 seconds on any step, troubleshooting text displays. Common things
to check are if the READY pendant network cable is plugged in, if the IPC is powered on, if the READY pendant

and IPC are connected to the same network, and if there's only one READY pendant and one IPC on that
network.

Note: The READY pendant IP Address is preset to 172.16.255.253. The network interface that the pendant
connects to should use IP Address 172.16.255.250 and Subnet mask 255.255.255.0.
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e Tap Admin and sign in. The default Admin password is "forgeadmin'.

Note: After installation, you have limited access to Forge/OS until you activate it with a license code. See

Activating Forge/OS with a License Code.

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 54



VERSION 5.3.0

ACTIVATING FORGE/US WITH A LICENSE CODE

There are two methods to activate Forge/OS: Online license activation and offline license activation.

The table below lists the requirements for each method.

Online License Activation Offline License Activation

= A 2GB or larger USB flash drive

= Aninternet-connected Forge/OS « An internet-connected PC

= Avalid Forge/OS license code
= Avalid Forge/OS license code

Tip: Connect a USB keyboard to the port on the bottom of the READY pendant to type in any text field in Forge/
OS.

u On the Settings app main screen, tap License.
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e Choose ONLINE LICENSE ACTIVATION if Forge/OS is connected to the internet. If not, choose OFFLINE
LICENSE ACTIVATION.

q If you chose offline license activation, follow these substeps:

u Insert the USB flash drive into your IPC. Tap START WRITING CERTIFICATE TO USB DRIVE.
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When the files finish transferring, tap NEXT. Follow the instructions on the screen to convert the
Activation Certificate to an Unlock Certificate using an internet-connected PC.

G Insert the USB flash drive back into your IPC. Tap UNLOAD UNLOCK CERTIFICATE FROM USB DRIVE.

q Wait for the file to finish transferring. When the file transfer is complete, remove the USB flash drive and
tap SAVE.

active, restart these license activation steps. Double-check your license code.

q Forge/OS returns to the licensing home screen and shows an active license. If the license status isn't
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CHOOSING PREFERENCES

These steps help you choose system preferences, including language, units, time, and network settings.

ﬂ To change preferences for the first time, go to General Settings:

On the Settings app main screen, tap General Settings.

u Change the Units of Measure, Time and Date settings, or the Admin login password.

Note: If you later forget your password, contact READY Robotics to reset it.
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e Check the Network settings in Forge/OS and set them as you want.

On the Settings main screen, tap Network.

u The table below lists the available network interfaces on your IPC. By default, the first interface is for the
READY pendant. You can't edit the pendant's interface in Forge/OS. Select another interface and tap Edit

to see the network settings.

Change the network interface to match the settings in the image below. Connect robots and other devices
to this interface through an Ethernet switch.
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APPENDIX B: KNOWN ISSUES

You may encounter programming issues when the EPSON robot comes near a singularity. THESE ISSUES ARE
NATIVE TO EPSON AND ARE NOT CAUSED BY FORGE/OS.

What is a singularity? A singularity is a position that prevents a robot from making certain movements. A
singularity can occur when two or more joint axes are co-linear, such as the axes of Joint 4 and Joint 6.

In a singularity, a robot cannot reach a specified waypoint due to physical limitations. This doesn't mean that it
can't reach the waypoint, but it is unable to move to the position in that way.

Important: When you move a robot near a singularity, the robot may move unexpectedly, speed up, or enter an
error state.

Two behaviors you may see near a singularity are excess jogging and rejected stop requests.

EXCESS JOGGING AT A SINGULARITY

When you jog the robot near a singularity, the robot may move for an extra 1-2 seconds after letting go of the jog
button.

This issue is the common with linear jogs on EPSON robots. Linear jogs move the robot's tool center point (TCP)
in the Cartesian space (X, Y, Z, Rx, Ry, Rz). Use joint moves around singularities.

When jogging the robot near objects, use a low speed to avoid unpredictable collisions.
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SI0P REQUESTS REJECTED BY THE ROBOUT

When the robot is moving through a singularity, it might not immediately stop with the READY pendant Stop
button or with an external safety device (such as a light curtain or a safety fence). However, the robot will always
immediately stop with the E-Stop.

Important: In emergency situations, ALWAYS hit an emergency stop button that is wired to the emergency stop
circuit of the EPSON controller.

For example, if you execute a circle move that has an arc point near a singularity, the robot might finish its entire
path of programmed motion regardless of any stop signal it receives (other than the E-Stop).

To minimize risk, use a low speed as you first build out your task. This will help avoid unpredictable collisions.
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APPENDIX C: TROUBLESHOOTING

Use this section to recover from an unresponsive robot or from build errors.

DRIVER KILL SWITCH FOR UNRESPONSIVE ROBOT

If a port fails to configure when you load the driver, you may lose all connection to the robot when you reboot.

To shut down an unresponsive driver, set 1023 (pin 27) to HIGH by making these connections:

= 0V to Pin 14 (Input common)
24V to Pin 27 (Input No. 23)

Tip: To check if I023 is set to HIGH, open the I/0 Monitor from the Tools menu. In the pop-up,
select All Inputs. Check if there's a red dot next to input 23.

While 1023 is set to HIGH, restart the robot. This setting prevents the driver from launching when the

robot powers up, allowing you to reconfigure the robot. The Runtime Controls window reads "“Kill
switch enabled, disable to start driver" until you set 1023 back to LOW (turning the red dot off).
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INITIAL DEVICE CONFIGURATION ERROR

When you set up your robot for the first time, you may see build errors.

Try deleting and re-adding the robot in System Configuration.
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n In the top menu bar, select Setup. Go into System Configuration.

Expand the Controller menu. Open Robot 1. Note what the settings of the configured robot are. If they
don't match your robot model, make a note of that.

e Click Delete and Yes to re-configure the Robot 1 file.
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u Click Add. Enter the robot's information. Then click OK.
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REBUILDING THE SOURCE CODE

You need to rebuild the source code:

= after you resolve a build error.

if the Epson encounters a stack error in the Epson logs while you are running a task. When this happens,
you will receive a Forge/OS message asking you to rebuild.

n In the top menu bar, open the Project dropdown. Click Rebuild.
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G If you see the prompt below, select Yes to overwrite the project on the controller.

-[E] lib_am_robot.prg
lib_amr_ser_cbor prg

lib_amays prg

-[E] lb_commands.prg
-[&] lib_functions prg

--[E] lib_robet_functions prg
lib_ser_chor.prg

main prg

ﬁ EPSON RC+ 7.5.0 - Project C\EpsonRCT0\Projects\EPSON_DRIVER - O X
File Edit View Project Run Tools Setup Window Help

D@ & & R E =120 55 & 7S % 5 @ o~ Cometion: USE L7
Froject Explorer 1 x :
E423 Program Files ~

lib_arr_ral prg

EPSONRC+ 7.0

‘Warning:

lib_queus prg
lib_ral prg Praject in controller is 'EPSON_DRIVER'. This is not the same
-] lib_robet prg as current PC project.

The project in the controller will be overwritten.

Continue?

main_maotion prg
main_state prg
main_system pra
motion_master.prg
motion_metion_circular prg
motion_metion_jog.prg
mation_maotion_joirt prg
motion_metion_linear.prg
motion_metion_pause_resu
-] mation_mation setscale
>

v

<

Status X
15:14:04 Linking...

Program EStop Safety Error \Warning Robet: 1, VT6A901S, VTE-A901S = No Tasks Running

a Verify that you have a successful rebuild by looking for "Build complete, no errors" in the Status window.

Status

15:32:26 Sending tests_language_strings_test_strings.prg
15:32:26 Sending tests_language_strings_test_string_ascii.prg
15:32:26 Sending tests_language_strings_test_string_compare.prg
15:32:26 Sending tests_language_strings_test_string_concat prg
15:32:27 Sending tests_language_strings_test_string_operations.prg
15:32:27 Sending lib_ral prg

15:32:27 Sending lib_ser_chaor.pry

15:32:27 Sending system_state_allcommands. prg

15:32:27 Sending lib_arr_ser_chor.prg

15:32:27 Sending lib_arr_ral prg

15:32:28 Sending lib_arr_robotprg

15:32:28 Sending lib_gueue prg

15:32:28 Sending robotl . pts

15:32:28 Sending EPSOMN_DRMWER. spr

15:32:28 Sending EFS0ON_DRIVER. ohj

15:32:29 Sending [OLabels dat

15:32:29 Sending UserErrars.dat

15:32:29 Sending EPSOMN_DRMER.vis

15:32:29 Sending EFSON_DRIVER.fg

15:32:29 Loading project in controller...

15:32:30 Build complete, no errors
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u Start the updated driver. Navigate to the top menu bar, open the Run dropdown, and click Run Window.

ﬂ To start the driver in Remote 1/0 mode, click the Enable Remote 1/0 button. Click Yes in the pop-up
window.
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DIGITAL OUTPUT CONFIGURED AS SYSTEM OUTPUT ERROR

You may see a "Digital Output Configured as System Output" error in Forge/OS or an "Error 2342: Cannot
change the status for output bit configured as remote output” in RC+.

For example, suppose you have Output 0 linked to the "Ready" signal. In the 1/0 Monitor, output bit
#0 has the label "Ready". On the READY Pendant, if you select the DCP checkbox next to Output 0 in
the robot's device configuration and then try to change the state of Output 0 in the robot's Signals
tab in the Device Controls app, you will get an error.

Follow these steps to unlink Output 0 (or other outputs) in RC+.

ﬂ In the top menu bar, click Setup. Go into System Configuration.
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G In the Controller menu, select Remote Control and then Outputs.

System Configuration ? *
--Startup Remote Control Outputs ose
= Controller

- General
- Corfiguration
- Preferences Output Signal Qutput # 2
- Simulator : 0
[} Drive: Linits ; :
- Robots Running 1
[#- Inputs / Outputs Paused p
=3 R_emote Control Errar 3 Defaults
' EStopQn 4 Load
SafeguardOn 5 —
SError 6 Save
wiarning 7 =
-R5232 MotorsOn Not used
&-TCP /1P AtHome Not used ™
[~ Security
[+~ Vigion
a Configure the output signals to an output bit (or select "Not used").
Note: You cannot select Output #8 or #9. These outputs are reserved by Forge/OS.
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APPENDIX D: ERROR RECOVERY

Some errors are not recoverable from Forge/OS. One such error is Error 4066: "Motion Command was attempted
in the prohibited area depended on joint combination." This error occurs when you move the robot outside of its
joint limits.

In these situations, the robot is not movable in Forge/OS or in the EPSON RC+ Robot Manager. In this case, use
the instructions below to recover your robot to an operable state.

e If necessary, reload your project:
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u In the top menu, go to the Tools menu. Open the Command Window.

G Turn motors off.

In the Command Window, type “Motor Off’, then hit Enter.

> Motor Off

G Turn a joint brake off.

Check which joint is out of the movable zone or in a state that it cannot move.
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G In the Command Window, type "Brake Off, [JOINT#]", then hit Enter. For example, to release the joint 3
brake:

Note: Depending on which joint that you are releasing the brake for and what position that joint is in,
you may need to catch the robot as it falls. Avoid damage to the robot and any nearby objects that it
might collide with.

> Brake Qff, 3

u In the Command Window, type "Brake On, [JOINT#]", then hit Enter.

> Brake Off, 3
> Brake Cn, 3
=

G Turn motors on.

G In the Command Window, type "Motor On", then hit Enter.

» Motor Cn
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RESOURCES

Want to learn more about how Forge/OS can empower you?

Visit READY.academy (ready.academy) for FREE hands-on courses to help you deploy a robotic system.

Visit READY.market (market.ready-robotics.com) for products and services offered by READY and our partners.
Visit our Support site (support.ready-robotics.com) for robot startup guides, FAQs, and more.

Visit our Resources page (ready-robotics.com/resources) for articles, whitepapers, and other resources.

If you encounter a problem and need to talk to someone, reach out to us.

= Email READY Robotics: support@ready-robotics.com
= Call READY Robotics: +1-833-732-3977
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